
ModelPro Interface Tutorial
Creating a 3-D Logo

A:1

This mini-tutorial is a step-by-step tour to help you
quickly familiarize yourself with the ModelPro Interface, and to access
particular features. For more 
detailed information regarding 
the Interface (Tools, Windows, 
and Palettes) consult the
appropriate Reference Manual
chapter. ModelPro 3.0 also
incorporates an on-line Help 
feature located under the 
Apple menu.

Get Started

Locate the
ModelPro application icon, 
and launch ModelPro by double-
clicking on the icon. Note that
ModelPro automatically opens 
a New blank file upon launch. 
Your double-width Tool palette 
is on the left; your Snapping palette is directly below the Tool palette;
your Groups palette is on the right over the 3-D preview window titled
Angled; counter-clockwise from top-left are your Top view, Front view,
and Right view drawing windows; at the top of the screen is the Tool
Info palette, and at the bottom of the screen is the Status Line palette.
The Statistics palette and Libraries palette may be accessed and
displayed through the Palettes sub-menu (Windows menu).

Fine-Tune Your Interface

In the Edit menu choose Preferences. Click on the icon
named Drawing to the left side of the Preferences dialog (note that the
default dialog is the top item (General). Set your Scale Units to Decimal
Inches and your Decimal Places to 1.000. Next, scroll down the list (to
the left of the dialog box) and click on the icon named Colors. Click in
the color box labeled Background Color. Set the color to a darker gray by
moving the slider (to the right of the color wheel) down. Take a moment
here to look at your other options in the Preferences dialog boxes (there
are five types of Preferences: General, Screen, Drawing, Grid, and Color. 

Start-up Window layout

Edit Menu
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When you are ready, choose OK to return to the
start-up screen. Choose Save Preferences to make
any changes permanent, so that the next time you
launch ModelPro, Preferences will be as you have 
set them here. Remember to Save often, so as not
to lose important, time-consuming operations.

Window Control

Do not be overly concerned about
exactly duplicating what is shown in the following
diagrams. Use the illustrations only as reference in
following the tutorial; some of them have been
edited for clarity.

Make the Front view active by clicking anywhere in the
Front view window. You may have already noticed that the
Selector tool is chosen as the default at start-up. Click in the
Zoom box on the Front view window to bring that view to
full screen.

Now we should be working with one drawing window 
(Front view). Click in the Zoom box on the Groups palette 
to compress the palette to show only its title bar.

Using the Spline Tool

Use the Spline tool to draw a closed 2-D shape. To be
sure that the last point lands on the first point (thereby closing the
shape), click on the Vertex Snap button (Snap palette) just prior to
placing the last point. Place the last point on the first point (or on the
shape, close to the first point) to automatically close the shape.

A spline shape is a succession of connected points. If you want the
connection between any two points to be a straight line, click just 
once at each point. If you want the connection to be a smooth curve
through a point, click-drag the point, as you draw, to expose its 
“handle bars.” For more information about the Spline tool, consult 
the Reference Manual.

Drawing Preferences dialog box

Zoom Front view window to full screen

Spline Tool
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Editing a Spline Shape

Select the spline shape with the Selector tool. Click 
on one of the vertices to expose its “handle bars.” (Remember, points
connected by straight lines may have only one handle bar showing 
(or none at all)). Click drag one of the “handle bars” (by one of its 
end points) to reshape the smooth curve through the point. Click-drag
the shape between two vertices to reshape another portion. Consult the
Spline tool information in the Reference Manual to learn more about
how to edit spline shapes.

Draw curved spline shape 
through a vertex

Use the Snap Vertex button to
complete the spline shape

Edit the spline shape by dragging 
a “handle bar”

Edit the spline shape by dragging the
shape between vertices

Snap palette



Using the Filled/Unfilled button

Note that the Filled/Unfilled button default is set to
Filled. This mode must be set prior to completing the shape for it to take
effect. This is true for spline shapes, quickdraw shapes, and Text shapes.
Click on the button to toggle between the Filled (shaded ellipse on 
the button) and Unfilled (clear ellipse on the button) modes.

Using a Quickdraw tool

Select one of the Quickdraw shapes (ellipse or polygon)
to draw (drag out) a second 2-D shape. The default Drag Mode 
(bottom of the ToolBar) is corner-to-center. Try dragging out several
quickdraw shapes using different Drag Modes. Then, select and delete all
of the extra Quickdraw shapes; leaving just one.

Duplicating Objects

Select the spline shape with the Selector tool. Choose
Clone from the Edit menu. Clone makes an exact duplicate of the
selected item,and positions the duplicate exactly on “top” of the original.
De-select all shapes by clicking in an open area with the Selector tool.

Select the clone as a whole object (bounding box
corners only will show) by holding the Option key
while making the selection, and move (drag) it to
a new position, not overlapping the original.
Remember to release the Option key after
selecting the object, and before moving the shape.
Remember to Save.
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Filled/Unfilled button

Drag Mode buttons

Clone and move the spline shape
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Controlling Your View

In the following section, using the Hand tool and the
Zoom boxes does not affect your model (the shapes); it just changes your
view of the model in the window.

Select the quickdraw shape and move it to a
position so that it is partially out of the field 
of view.

Select the Hand tool and drag in the window to
reposition your view so that the element you just
moved is completely visible in the window.

Use the Selector tool to again reposition one of the
elements partially out of the field of view.

Click in the Zoom In and Zoom Out boxes (lower-
right corner of the window) to adjust the view to
once again make all of the elements completely
visible in the window.

One final time, reposition one of the elements partially out of the field 
of view.

This time click in the Fit-to-Window box to make all of the elements
completely visible in the window.

Finally, select the quickdraw shape and remove it from the data base by
pressing the Delete key on the keyboard; you will not need that shape for
your logo.

Click in the Zoom box to return to the 4-view interface.

Move the quickdraw shape partially out
of the view

Zoom In

Window resize

Fit-to-window

Zoom Out
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Click in the Angled view window to make it active. Select the Smooth
Shaded view button, to confirm that your shapes are closed and filled
(surfaced). Use the Hand tool to manipulate your view in the window;
click-drag in the Angled view window to rotate the view intuitively.
Enable one of the grids, to find your orientation, by clicking on the Top,
Front or Right Grid button.

Using the Color Picker

Select one of the shapes and change its color
by clicking and holding in the Color box, then drag to the
desired color and release the mouse. Make each of the three
shapes a different color.

Using the Text Tool

Select the Text tool. In the Tool Info palette, select a
font from the pull-down menu; click in the character-string box, then
type in a single capital letter (make the letter one with a counter (hole)
in it, i.e. R or O). In the Front view window, position the cursor as
desired to place the upper-left corner of the character-string, then click
to place the character. Click-drag one of the two corner control points to
resize the character (hold the shift key to resize proportionally). Double-
click in the window, or click on the Engage button in the Tool Info
palette to place the character. Click the Zoom box on the compressed
Groups palette to uncompress it. Note that you have created a new item
(folder) in the Groups palette, labeled with the letter you chose for the
character (in this case “R”).

Smooth Shaded view

Wireframe view

Grid buttons

Color Picker

Color box

Text tool
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Select the text character shape with the Selector tool (hold the Option
key to select it as a whole). Ungroup it by selecting Ungroup in the
Group menu (�-U). Remember to Save.

Using the Groups Palette

In the Groups palette, notice that the text character’s
folder has “opened” to expose its pieces. One of the pieces is labeled
“Joined Splin 1.” Select it by clicking on its name in the Groups palette,
then delete Joined Splin 1 by pressing the Delete key on your keyboard.
We do not need this piece for what we want to do. We are left with two
pieces in the text character’s folder: in this case, R1 and R2. These
remaining two pieces are not displayed; the adjacent box in the 
Display column is clear. Click in these Display boxes to toggle the
display “on” (black box) for R1 and R2. Now, choose Redisplay from 
the Windows menu (�-D), to redraw the screen showing all of the
newly “displayed” items.

Text Tool Info palette

Using the Text tool and selecting the
Text character shape as a whole

Groups palette After Ungrouping Display R1 and R2
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Using the Delete Vertex tool

Use the Selector tool to select the counter (hole) in 
the text character shape. All of the counter’s vertices should be visible.
Select the DeleteVertex tool (pop-out from the Add Vertex tool). Click
once on each of the counter’s vertices until all have been deleted.

Hold the Command key and click on any Fit-to-Window button to make
each of the four views Fit-to-Window.

Using the Scale tool

In the Front view, select one of the spline shapes as a
whole (remember, use the Option key). Select the Scale tool. In the
Tool Info palette, select Center of Object from the Anchor pull-down
menu; this positions the point about which the scale will occur. 

Delete Vertex tool

Using the Delete Vertex tool

Scale tool
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Now, “grab” the upper-right bounding box point with the Scale tool, and
drag diagonally toward the center of the shape, to reduce the size of the
shape (hold the Shift key to constrain the scale to be proportional).
Consult the Reference Manual for a detailed description of the Scale
tool functions. Select the newly reduced shape, and reposition it to take
the place of the hole that we deleted earlier from the text character.

Joining Elements

In the Front view window, select both the repositioned
spline shape and the remainder of the text character shape. Choose Join
Elements (�-J) from the Operations Menu. Now we have a 2-D
character shape with a customized counter (hole).

Rotate Tool Info palette

Using the Scale tool

Reposition the resized spline shape

Select both shapes
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Using the Extrude Tool

In the Front view, select the remaining spline shape, and
position it so that it overlaps the customized text character shape. In the
Right view, position the spline shape so that it is just forward (left) of
the text character shape. Select both the text character shape and the
shape which overlaps it; each as a whole. Choose the ExtrudeTool and
double-click in any of the drawing windows to extrude the shapes using
the default setting. Remember to Save.

Re-position the remaining spline shape

The intuitive Extrude
tool controls

Right View after the Extrude

Extrude tool



ModelPro Interface Tutorial
Creating a 3-D Logo

A:11

Create a Torus Shape

In the Right view, position the cursor roughly centered
above the extruded shapes. Press the Space Bar on the key board. You
will hear the computer say “Lock.” This sets the Depth Lock in the y and
z dimensions; meaning that objects drawn in the Front or Top
views will be located at this position in the y or  z dimension.

Select the Center-to-Corner drag mode. Select the Torus 
3-D primitive tool, and click-drag in the Front view window
from near the center of the extruded shapes. Drag until the
preview in the all windows shows the torus as you want it,
then release.

Hint: Use the Depth Lock to position
objects in 3-D space as you draw in
the 2-D orthogonal views.

Setting the Depth Lock

Center-to-Corner drag mode

Torus 3-D primitive tool

Torus preview in all windows

Setting the Depth Lock
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Complete the Logo

To complete your 3-D logo, select the Torus shape as a
whole. Choose the 3-D Rotate tool (pop-out from Rotate tool). Set the
Anchor to Center of Object in the Tool Info palette pull-down menu.
Click-drag in the Front, Top, or Right  view window to rotate the lathed
shape to the desired position. Note that your preview in the drawing
window is 3-D (not orthogonal). Click on the Smooth Shaded view
button in the Angled view window to preview your 3-D logo. Now, you
are ready to apply surface textures and animate your logo in Presenter
3.0; choose Render/Animation from the File menu. Remember to Save.

Using the 3-D Rotate tool

Final shaded Angled view


